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WORKSHOP DESCRIPTION 

Reports are used to retrieve and present data as meaningful information in hard copy format. 
Different types of reports include mailing labels, invoices, and monthly reports.  Reports can 
group records into many levels, compute totals and averages by checking values from many 
records at once, and can be attractive and distinctive because you have control over the size 
and appearance of everything on the printed page. 

PREREQUISITE 

Access 2003 Queries and Access 2003 Forms 

OBJECTIVES 

Participants attending this workshop will: 

• Identify terms associated with report creation 

• Become familiar with report sections and formatting tips 

• Create mailing labels 

• Create a summary report 

• Use bound and unbound controls in report modification 
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What is a Report? 
Reports are used to retrieve and present data as meaningful information.  Different types of reports 
include mailing labels, invoices, monthly reports, yearly summaries, and department phone lists.  
 
• Reports display only the information you want, the way you want to see it. 

• Reports group records into many levels and compute totals and averages by checking values from 
many records at once. 

• Reports can be attractive and distinctive because you have control over their design. 

Terms to Know 

Control 
Everything added to a report – text, a picture, a graph, even a field from a table is a control. 

 Bound Control 
A bound control is a control on a report, whose contents are bound to a particular field in the 
underlying table or query.  For example, a text box that displays an employee's last name is 
bound to the Last Name field in the Employees table.  Binding is the act of setting up the 
controls on the report. 

 Unbound Control 
Information in a report you specify with the use of either the Wizard or Design View such as title 
and/or column headings or labels. 

 Calculated Control 
Any control in a report that involves a calculation of one or more fields, a date and/or time 
expression, or a page number. 

 

Sections of a Report 
Information will appear on the report depending upon where certain controls are placed in the design of 
the report. 
 

 

1  University Computing and Communications Services 



  Access 2003 Reports 

How to Set up a Report 
 
 
The title and column headings of the report are stored in the report 
design and are placed in the Report Header and Page Headers 
respectively. 
 
 
Data is retrieved from the underlying table or query which the report is 
based on and can be viewed in the Detail section of the report. 
 
 
Totals come from an expression which is stored in the report design.  
Totals can be placed in either the Report Footer or the Page Footer. 
 
 

• If data is retrieved from more than one table, the report must be based on a query. 
 
• Prevent blank pages by making sure the report width plus the margins do not exceed the paper size 

specified in Print Setup. 
 
• Set page/print orientation in File, Print Setup, Orientation prior to creating a report. 
 
• To move and/or size any report controls, the sizing/moving handles must be active. 
 

Create a Report  

Creating a report using the AutoReport Wizard 
This is the easiest way to create a report in Access.  The wizard sets up margins, alignments, and 
indentations where necessary.  After the report is created, you may alter it to your specifications. 

1 Open the Northwind database. 

2 In the Database Window, click the Tables button and select the Customers table. 

3 Use the drop-down list next to the New Object button and choose AutoReport. 

4 Save the report as rpttblCustomers. 

5 Close the report. 

6 Close the Customers table. 
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Creating a report using the Report Wizard 

1 In the Database Window, click the Reports 
button. 

2 Click New. 

The New Report Dialog Box will appear. 

3 Choose the table or query that contains the 
information on which the report will be based.  
Choose the Employees table. 

4 Choose the Wizard to be used. Choose Report 
Wizard. 

5 Click OK. 

6 Add the following fields FirstName, LastName, Title, Address, City, Region, and PostalCode. 

7 Click Next. 

8 Add Title for the grouping level.  Click Next. 

9 Sort by LastName and then FirstName.  Click Next. 

10 Choose the Stepped layout and click Next. 

11 Choose a style and click Next. 

12 Name your report rpttblEmployees and click Finish. 

13 Close the report. 
 

Using Design View 

1 In the Database Window, click the Reports 
button. 

2 Click New. 

The New Report Dialog Box appears. 

3 Choose the table or query that contains the 
information on which the report will be based.  
Choose Suppliers. 

4 Click OK 

5 The report window in Design View will open. 
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Note: It is often best to create a form using the most basic form of the Report Wizard and then make 
modifications in the Design View.  In this way, the margins and formats for the headers, footers and 
detail section will be created automatically. 
 
6 Open the field list and add the following fields: CompanyName, ContactName, ContactTitle, 

Address, City, Region, PostalCode, and Country. 
 
7 View the report in Print Preview mode. 
 
8 Save the report as rpttblSuppliers. 
 
 

Adding Controls to a Report 

Labels 
Labels are placed in the page header to represent the field headings. 
 
1 Open the rpttblSuppliers report in Design View. 
 
2 If the toolbox is not open, click the Toolbox button. 
 

3 Choose the Label Tool.   
 
4 Click to place an insertion point in the page header. 
 
5 Type the label Suppliers. 
 
6 Resize, format, or move the label if necessary. 
 

Changing the Text Box defaults 
You can change the defaults for the controls such as the text box.  One default that is particularly useful 
to change is making the label not appear when the text box is created. 
 
1 Select the Text Box tool. 

2 Choose View, Properties. 

3 Change the following: 

  Auto Label: No 
  Auto Colon: No 
  Label X: 0 in 
  Label Y: 0 in 

 
4 Change the default back to: Yes, Yes, -1, and 0. 
 

Viewing the Report Header and Footer 
 
1    With the report open in Design View, choose Report Header/Footer from the View menu. 
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Calculated Text Box 
A calculated text box contains calculated fields or information not associated with the table or query. 
Information such as the time, date or a page number can be placed in a report with the proper 
commands.  

Time/Date Text Box 
 
1 With the rpttblSuppliers report open in Design View and the Toolbox open, click the Text Box 

tool. 

2 Click to place the text box on either the Report Header or Footer. 

3 Delete the label of the text box if necessary. 

4 Place the insertion point in the text box by clicking in it. 

5 To place the current date:  =Date() 

5(a)   To place the current time: =Time() 

6 Size, format, or move the text box as needed. 

Page Number Text Box 
 
1 Add a Text Box onto the Page Footer. 

2 If necessary, delete the label of the text box. 

3 Click inside the text box. 

4 To place just the page number type: =Page 

4(a)  To place the code for Page # of # type: ="Page " & Page & " of " & Pages 

5 Close the report. 

Grand Total Text Box 
 
1 Create a new report in Design View based on the Orders table. 

2 Open the Field List Box. 

3 Click on the Text Box tool. 

4 Click on the field to be calculated.  Choose the Freight field, hold down the left mouse button and 
drag the field onto the section of the report where the total will appear.  Release the mouse button. 

5 Change the label to Freight Total. 

6 In the text box, type the following: =Sum(Freight) 

Note: If the fieldname has a space, use brackets around the fieldname: =Sum([fieldname]) 
 

7 Save the report as rpttblOrders(Freight). 
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Adding a Picture 
A picture or any OLE object can be placed onto a report.  You can use the object frame or the Image 
button. 
 
1 Open the Toolbox. 

2 Click the Image Button. 

3 Click on the Report Header to place the frame. 

The Insert Picture Box appears. 

4 Navigate to c:/Windows and choose a graphic file (e.g. Coffee Bean.bmp). 

5 Click OK. 

6 Once the picture is placed, open its properties. 

7 In the Format tab, change Size Mode to Zoom. 

8 Resize the picture to fit in the design of the report. 

Note: You can double-click on the image sizing border to automatically size the graphic. 

Print Setup, Previewing, and Printing 
As you are nearing the end of setting up the controls of the report, it is necessary to set up the printing 
options of the report. Unless the defaults are changed, all reports will be oriented to print portrait-style 
with 1-inch margins on all sides. 
 

Page Setup Dialog Box 
 
• Select File, Page Setup. 

• Under Page, Orientation, choose either Portrait or Landscape. 

• Change the margins as needed.  
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Setup Preview Buttons 

Layout Preview Button 
Available in Design View, the layout preview shows the basic layout of the 
current report with a limited number of records displayed.  If you wish to view 
the report exactly as it will be printed, choose Print Preview instead. 

Print Preview Button  
Shows how a report, form, datasheet, or module will appear when printed.  Includes all records in the 
report. 

Creating Labels Using the Labels Wizard 
The quickest way to create printed 
labels based on a table or a query is 
to use the Labels Wizard. 

 
Figure 1. Database Window with the Reports Tab activated 

 
1 Close any open reports.  In the 

database window, click on the 
Reports button. 

 
2 Click the New button. 
 
3 In the New Report window use 

the drop-down list to select the 
table or query that contains the 
data you will use for your labels, 
choose the Customers table. 

 

 
Figure 2. New Report window 

4 Select Label Wizard, and click the OK button. 
 
The label wizard will now activate. 
 
5 Select the appropriate Avery number based on the 

dimensions of the label sheet you will be using and 
click Next.  Choose C2354.  Click Next. 
 
Note: to customize the label size: 1.  Choose 
Customize.  2.  In the next window, choose New.  3.  
Give your label a custom name and change the  size 
by clicking in the fields that are set to 0.00.  4.  Click 
the OK button.  5.  If you have created custom label 
sizes, you can view them by clicking the Show 
custom label sizes checkbox after starting the label 
wizard. 

 
6 Choose the formatting options you would like.  Change the font to Times New Roman, 10 point 

size, Normal font weight and click Next. 
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7 Choose the fields you would like to 
include on your labels by selecting 
the field from the Available fields: 
list and clicking the add field button 
when on the appropriate line.    
Choose the following fields: 
CompanyName, ContactName, 
Address, City, Region, PostalCode, 
and Country. 

 

 
Figure 3. The Labels Wizard Fields window 

Note: in the Prototype label: panel, be 
sure to add the appropriate spaces and 
punctuation. 
 
8 Click Next. 
 
9 Choose the fields you would like to 

sort your labels by and click Next.  Choose Country and Company Name and click Next. 
 
10 Name your report rpttblCustomers(Labels) and click Finish.  Close the report. 
 

Creating a Summary Report 

Create the New Total Orders query 
 
1 Select the Queries button. 
 
2 Click New, Design View, then OK. 
 
3 Add the Customers, Orders, and Order Details tables to the grid then close the Show Table 

window. 
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4 Add CompanyName from the Customers table; OrderID from the Orders table; and UnitPrice, 
Quantity, and Discount from the Order Details table. 

 
5 Save the query as qryNewTotalOrders. 
 
6 Sort Ascending by CompanyName. 
 
7 Add a total price calculating fields to the right of the Discount field by clicking in the field row and 

typing Total: [UnitPrice]*[Quantity].  Run the query to test the results. 
 
Note: to view or write the contents of a calculated field it is often easier to Zoom the field by pressing 
Shift+F2. 
 
8 Add a second calculating field to the right of the Total field by typing WithDiscount: [Total]-

[Total]*[Discount].  Run the query to check your calculation. 
 
9 Save and close the query. 
 

Create the New Total Orders Summary report 
1 Click the Reports button. 
 
2 Click New then select Report Wizard and qryNewTotalOrders query.  Click OK. 
 
3 Add all of the fields to the report then click Next. 
 
4 In the How do you want to view your data? panel, choose by Customers, then click Next 
 
5 Do not add a grouping.  Click Next. 
 
6 Sort ascending by Total. 
 
7 Set Summary Options to sum Total and With Discount. 
 
8 Show Detail and Summary. 
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9 Click OK then Next. 
 
10 Use the Stepped layout in Landscape, then click Next. 
 
11 Set the style to Bold, then click Next. 
 
12 Title the report rptOrderDetailandSummary. 
 
13 Click Finish to display the report. 
 

Modifying the Report 
1 Open the rptOrderDetailandSummary report in Design View. 
 
2 Change the Sum calculation fields to currency format. 
 

Note: View the properties of the fields and click on the Format tab. 
 
3 Edit the report header control rptOderDetailandSummary to read Order Detail and Summary. 
 
4 Edit the page header control WithDiscount to read Adjusted Total. 
 
5 Change the Company Name to bold, italic and 10 point. 
 
6 Change the spacing and alignment in the Detail and Page Header sections to align the data. 
 
7 In the CompanyName footer area list only the count information.  Delete the following: =”Summary 

for “ & “’CompanyName’ = “ & “ “ &.  Add the = to the beginning of the calculation. 
 

Note: The field should now contain the following: =[CompanyName] & " (" & Count(*) & " " & 
IIf(Count(*)=1,"detail record","detail records") & ")" 

 
8 Preview the changes. 
 
9 Close the report. 
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